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Instruction Manual

Content of this Instruction Manual

EMU is used for EOS MOVIE Utility.

In this manual, the windows used in the
examples are from Windows 8.1.

Camera model is displayed as an icon.
Example:EOS-1IDC » [ 1DC
0} displays the relevant camera model.

» indicates the selection procedure of the
menu.

(Example: [File] menu » [Exit].)

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.
Click to move to the relevant page.

. Marks information that should be read
before use.

: Marks additional information you may find
helpful.

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ . next page
€D : previous page
: return to a page you had previously

displayed
Click on the headings on the right side of the
screen to switch to the contents page of that
heading. Also, click the item you want to read
about on the table of contents to move to the
relevant page.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction System Requirements

Introduction

EOS MOVIE Utility (hereinafter, “EMU”) is software for playing, merging Refer to the Canon Web site for information on the system
and saving MOV format movies shot with the supported camera. requirements.
Main Features of EMU Su Orted MOVIeS Contents
With EMU, you can smoothly play movie files shot with the p p
supported camera. You can also use View Assist for playing movies Movie type Extension
shot with an EOS-1D C with Canon Log gamma. In addition, you can : - H th th . Preparation
consecutively play back multiple 4 GB movie files created from one MOV format movies shot with the supported camera MOV
clip (shot successively), merge them into a single file, and save it * \/ideo snapshot albums are not supported.
(W|th EOS'lD C, EOS'lD X Mal’k ”, EOS 5DS/EOS 5DS R, and Video files in MP4 format are not Supported_
EOS 7D Mark I1). Extracting still images is also possible. SBasic
creen
What is Canon Log gamma? Supported Camera
This function allows rich gradation expression from dark points to
bright points, applying a wide dynamic range. It maximizes the EOCS-1DC EOS-1D X Mark I EOS-1D X Playing Back
excellent capability of CMOS sensor.
P Y Egg ggglR EOS 5D Mark Il EOS 6D
What is a movie clip?
. . . p . o . EOS 7D Mark I EOS 70D - Confirming File
A movie recorded in a single shooting operation is called a movie Information
clip.
(D Do not remove the memory card from the card reader during Saving
access.
Exiting EMU
Reference
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Installing the Software

(D When installing this software, an administrator-level privilege is
required.

Double-click the compressed EMU file (.zip format)
downloaded from the Canon Web site to open it.

Double-click “emuw1.5.0-installer.exe” in the folder.

Follow on-screen instructions for installation.

Starting up EMU

Double-click the desktop shortcut.

ﬁ Double-click
&

EUSITTOVIE
Wislliay

EMU starts up and the main window appears.

v

& EOS MOVIE Utility - olEl|
il

.

- Timecode 00:00:00:00 Duration 00:00:00:00 Playback Rate x 1.0

LUT £ 200%

| [m

|§| Starting up multiple EMU at the same time is not possible.
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Basic Screen

Introduction

e
]
|
=

Main Window

You can view, play back, stop movie clips, save still images or merge and save movie files in the main window. Contents
1] EOS MOVIE Utility = E
File View Marker Tools ﬂelp‘ l Menu

. Preparation
Menu to execute all functions. P

Basic
Screen

Playing Back
Preview area —
Displays a clip to be played back.
Confirming File
Information
Saving
e
: : Exiting EMU
Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0
—
Control area
CLUT O 200% v 5 For operations such as controlling Reference
= (@ ([P [Y[err] (A > [ [>] [ A][he] +h] [AE playback, capturing still images, J
merging and saving movie files.
If you narrow the width of the main window, some of the items in the
control area may be hidden. In this case, use the menu to control EMU. @ @
(D If the message “Cannot open this file” is displayed, use software @
other than EMU, such as the movie playback application specified

with the computer’s OS settings, to play back the movie file.



Playing Back a Movie Clip

The method for playing back a movie clip is described here.
It is recommended that you first copy the folder on the memory card in
which the movie clips are saved to your computer using a card reader.

Movie Clip Playback

In the main window, select the [File] menu » [Select
a clip folder...].
The [Browse For Folder] dialog box appears.

Select the folder where the movie clip to play is
saved, and then click the [OK] button.

Browse For Folder “

Specify DCIM folder.

Bl Deskiop
A o000
48 This PC

- B Videos
4 Local Disk (C)
» i DVD Drive (D)
4 oy EOS_DIGITAL (E:)
MISC

[ Libraries

- €l Network

> 000K

The [Clip list] dialog box appears.

You can also select folders on the memory card directly by
inserting the memory card in the card reader and then connect it
to the computer.

You cannot directly select folders on the camera’s memory card
by connecting the camera to the computer.

(D Movie files shot with a camera are recorded on the memory card
with the folder structure shown below.

| DCIM '| 100EOSxX

or
100CANON

1 MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

] 101EOSxx
or
101CANON

1 MVI_xxxx. MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

I | 102EOSxx
or
102CANON

With this software, if the above folder structure is not maintained, it
may not be possible to play back the movie clips properly. When
playing back movie clips, make sure the above folder structure is
maintained and the DCIM folder at the upper layer of the folder
structure is selected. Even when the folder structure is maintained,
be aware that it may not be possible to play back the clips properly if
the name of the selected folder, originally [DCIM], has been

| MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

changed to another name.
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Select the movie clip to be played back in the [Clip
list] dialog box.

Clip list E

Display Mode: | B8

Sort | Shooting Date/Time ~ | | Ascending

== Rating Comment
1MV1_DOD1 ok

MVvI_0002 et d
maooos  ff wewwex

MVI_000 oSSt

mviooos  f eweex
MV1_0008
MVI_D0D3
miooio f kekek

The image of the movie clip appears in the main window.

You can click the [ ] button or [ ] button at the top of the
[Clip list] dialog box to change the manner in which items are
displayed.

You can use the [Sort] function to display items in the [Clip list] by
conditions such as [Shooting Date/Time], [Clip Name], [Clip
Duration], or [Rating].

You can change a [Rating] or enter a [Comment] in the [Clip list]
in the menu that appears when selecting the clip with right-
clicking with the mouse.

In the main window, click the [ [__» |] button.

EOS MOVIE Utility = &

Eil

e View Marker Tools Help

" N Timecode 01:20:48:00
&
0
N A

H
OILUT O 200% +

) )5 Y LP (Y T 4‘ > " 1>

A he] A A=

The movie clip is played.

Although time-lapse movies have no time codes, the start time
code of such clips is indicated as 00:00:00:00 when played back
in EMU.

Note that in such cases, [*] is added to the time code indication.
For operations during playback, see p.9 to p.13 (“Playback
Control” to “Switching the Movie Display Size”).

(D Consecutive playback of multiple 4 GB movie files created from one
clip (shot successively) is supported for [ 1D C | [1D X MklI)

(5DS/5DS R | (7D MK 11} .
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Playback Control

During playback, buttons allow you to perform the following operations.

In point marker (display only)
Out point marker (display only)

:03:15:04 Playback Rate x 1.0 A0 i

—_=

N Timecode 01:22:2*5:10 Duration 0
= 1
s |

LT O 2000 v

- I AL S A A I S SR

SR
m

el
o A

' |
Play/
Stop Next frame
Previous Adjust playback speed
frame

Jump to the frame at the Out point
Play a specified range

Jump to the frame at the In point

Set the Out point (ending point)*

Set the In point (starting point)*
Rotate image

*These buttons specify the In (start) and Out (end) points when specifying
a playback range (p.11) or saving multiple still images (p.18).

If you rotate an image, the rotated state is maintained and also
applies the next time you play back the movie clip. Note that the
rotated state is not maintained for playback on a camera.

If you rotate an image, the rotated state also applies to any still
images you extract and save from the movie clip.

In the [Clip list] dialog box, you can switch between movie clips
with the <T><!> keys on the keyboard or by clicking the mouse.
You can also double-click a movie clip name in the [Clip list]
dialog box to play back a movie clip.

Even if you close the [Clip list] dialog box, the content of the list is
saved. If you click the [ |g=| ] (Clip list) button in the control area or
select [Clip list...] from the [View] menu, the [Clip list] reappears.
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Adjusting Volume

You can adjust volume during playback with the volume slider.

Moving the Playback Position

You can move the playback position with the frame position slider.

Drag the volume slider left or right.

o R Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A i
——

CILUT O 200% ]

¥ I @@ Y[ P Y s Al > |Lannll g A 0« 2h| 0=

Volume slider
Mute button
To temporarily turn audio off, click the [ ] (mute) button.
Changing the Playback Speed
You can change the movie playback speed.

Click the [[I» 1] button while a movie is played.
Playback speed Current
adjustment button playback speed

R Timecode 01:22:26:10 Duration 00:03:15:04 Playback I!Qate x 1.0 A i
——
- 0 Bi=
Ot O 200% v | -H
) Q|2 [ Y]\ (Y [NF 50 4l > Ll A A« R A=

Each time you click the [[_ > ] button, the playback speed
changes.

|§| You can change the playback speed on the screen displayed by

selecting [File] menu P> [Playback speed settings...].
Audio is not played during playback when playback speed is
other than x1.0.

Drag the frame position slider left or right while a clip
Is played or stopped.

Frame position slider

Playback Rate x 1.0 A

=

N Timecode 01:22:26:10 Duration 01:03:15:04
=

]

2

OLWTO 200% +
-0 Dl (2 [V PN Y1) 2T 4l > > LIRS LS

w [m
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Setting Markers

Markers can be used for tasks such as specifying the playback start
position. Up to 20 markers can be set.

Drag the frame position slider left or right and click
the [ 2 ] (Add marker) button at the position where
you want to set a marker.

-

d R Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 P
&
0
I A

CWIT O 2009% v
) B2 VP Ye YT 4l » > || O.‘ | A=

0 m

The marker is set.

V = Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A0 i
—
& =
— ©

(] (] (] []
OWTO 100% v
) Sal (@] [P [N [F 2 [ 4l > > |l A A 20 A=

| m
it

A0
T

Click the [ |8« ] or [ *2 ] button to select the next marker in the
arrow direction and display the frame at that position.

If there is no other marker between the selected marker and the
start of the clip, the first frame in the clip is selected and
displayed. If there is no other marker between the selected
marker and the end of the clip, the last frame in the clip is
selected and displayed.

Click the [ &= ] (Marker list) button to display the list of markers.
It displays a numbered list of markers and time codes in order
from the beginning of the clip.

Marker list “
Number Timecode
1 01:22:26:10
2 01:22:34:22
3 01:22:43:23
4 01:22:50:09
Move Delete Capture allimages

« Select a number from the list and click the [Move] button to
move the position of the selected marker, and the frame at that
position is displayed. Effective when only one number is
selected.

« Select a number from the list and click the [Delete] button to
delete the selected maker.

* You can save the frames at all the marker positions on the list
as still images. (p.20)

You can set a marker by clicking the [ | & ] (Add marker) button

even during playback.

@ The marker settings in the selected clip are saved automatically,
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Playing a Specified Range

You can play back only a specified range of a selected clip.

Follow steps 1to 3in “Movie Clip Playback” (p.6).

Drag the frame position slider left or right until the
frame where you want to start playback appears,
then click the In point button.

Playback Rate x 1.0 A1 i
—

d ~ Timecode 01:21:35:24 Duration 00:03:15:04
-
[ A

OwT O 200% v
) @l OV IRk ke ARET 4 ll » > | | e >R A=

el %

H

1

In point button  In point marker

The In point marker is now displayed, and the starting point for
playback is set.

You can click this button even during movie playback to specify
the In point.

Once you have specified the In point, you can jump to the frame
at the In point by clicking the [ [¥¢]] (move to IN point) button. If no
In point has been set, clicking this button jumps to the first frame.
You can click the [ [+ ] (move to IN point) button even during
movie playback.

Drag the frame position slider left or right until the
frame where you want to stop playback appears,
then click the Out point button.

N Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A i

- \ Hi=
& 1 “V‘% =

OLUT I 200% v
7} @ | 1@‘* >F| F 2 ] » | A A« A A=

I |

Out point button Out point marker

The Out point marker is now displayed, and the ending point for
playback is set.

You can click this button even during movie playback to specify
the Out point.

Once you have specified the Out point, you can jump to the
frame at the Out point by clicking the [ [*f] ] (move to OUT point)
button. If no Out point has been set, clicking this button jumps to
the last frame. You can click the [[*] ] (move to OUT point) button
even during movie playback.

The maximum range between In and Out points is one hour.
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Click the [ »r ] (Play IN-OUT) button.

-

d R Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 P
—
- 1 r
s ‘ S e

CWIT O 2009% v

) @l | Y|r 1«@»! dl | Lnnll3 A A A S

0 m

The range of the clip between the IN point and the Out point is

played back.

The In and Out points can be removed from [Marker] on the main

window menu.

Select [Delete IN point], [Delete OUT point], or [Delete both IN

point and OUT point] as required.

When no In or Out point has been set, the range played back is

as follows.

* When no In point has been set, the playback range extends
from the first frame of the clip to the Out point.

* When no Out point has been set, the playback range extends
from the In point to the last frame of the clip.

* When no In point and no Out point have been set, the playback
range is the entire clip.

Select [Play IN-OUT looped] from [Tools] on the main window

menu to start looped playback between the In and Out points of

the clip.

|§| The In and Out point settings in the selected clip are saved

automatically, and the settings continue to be effective the next time
you work with the clip in EMU.

Playing Back Movies Shot with Canon Log
Gamma set to [On]

) ipcC

Movies shot with an EOS-1D C with Canon Log gamma (p.2) set to [On]
will look dark and have low contrast by default. If you apply a look-up
table (LUT) and play back the clip, you can check the clip with an image
close to normal display.

Checkmark the [LUT] checkbox.

Playback Rate x 1.0 | i
——

i ~ Timecode 01:22:26:10 Duration 00:03:15:04
-
0
[

4
UTD 200% v
-0

oo ]‘:‘:?

H

(@] [V [P [Ye VT a7 dl > > || e i A+ 0 A=
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Playing Back in Full Screen

Play back a movie.
Follow operations in “Movie Clip Playback” (p.6).

In the main window, select the [View] menu » [Full
Screenl].
The movie played back is displayed in full screen.
You can also double-click the preview area to display the movie
in full screen.
To cancel full screen display, press the <Esc> key or double-click
the mouse.

Switching the Movie Display Size

You can apply either [Fit to window] mode, [100%] mode, or [200%]
mode as the method for displaying a movie in the preview area.

If you remove the checkmark from the [100%] or [200%]
checkbox in the magnification change list box, the display will
change to [Fit to window] mode.

In [100%] or [200%] mode, you can use the guide area, which
represents the entire image, to check the position of the image
within the preview area.

If you checkmark the checkbox under the [View] menu P [Do not
zoom when fitting to window], the movie is displayed in the
preview area at actual pixel size with no enlargement.

Enlarged position in guide area

CILUT ¥ 1009 +

Select the [View] menu » [Fit to window]/[100%] or
[200%)].
The image is displayed in the preview area with the selected
display mode.
You can select [100%] or [200%] in the magnification change list
box in the control area.
In [Fit to window] mode, the image is displayed completely within
the preview area.
In [100%] mode, the image is enlarged to 100% (actual pixel
size) and displayed in the preview area.
In [200%] mode, the image is enlarged to 200% and displayed in
the preview area.
To change the display position of an image in [100%] mode or
[200%] mode, drag the image in the preview area.
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Confirming the Movie File Information |
Introduction
You can display and confirm shooting information for movie clips. Shooting Information [~ |
Item value »
Click the [ &= ] (Clip list) button in the control menu gy content
. N Compression format MPEG-4 AVC/H. 264 on en s
on the main window. e T
Camera Body No. JCOCCOCCOGOL -
v 2 Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 a0 5 fx::”i:a"emme :’;;’f::ﬂ’“ S
- Clip Duration 06 00 XK
S : . Tonrams g Preparation
OWwTO 200% ~ = fudio Channel 2ch
) | (¢ ARRE AR L2 4REY 4 4l » | A A« (A= Audio Rate 48 kHz
Audio Format LPCM —_—_
The [Clip list] dialog box appears. o et 7o 3 s
Note that this function is available after you select a folder in oo e ig? Basic
. . . . . Tv(Shutter Speed) 1/30
which the movie files to be confirmed are saved. If no folder is Mg E] S8 e Screen
selected, follow steps 1 to 2 in “Movie Clip Playback” (p.6) to o et ——
SeIeCt a fOIder- \C"J:'vr\‘:enBL;:nce Mode g:;light v
In the [Clip list] dialog box, select a movie clip to Playing Back
display its shooting information. —
Click the [ i ] (Shooting information) button in the C?nffirming File
: . nformation
control menu on the main window. '
™ Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A0 @
- Hi=
; :
CILUT O 200% ~ BH Saving
) )| || F | (Y| YF| [+F 4l > Ll A A+ >R A=
The shooting information is displayed in the [Shooting
Information] window. Exiting EMU
The shooting information includes the model name of the camera
used, and the items displayed may differ depending on the
settings used during shooting.
Reference
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Saving Still Images

Still images can be extracted and saved from the current movie clip.

Still Image Capture Settings

First, complete the settings for how still images are saved from movies.

In the main window, select the [File] menu » [Still
Image Capture Settings...].
The [Still Image Capture Settings] dialog box appears.
On the [General] tab, complete the settings as

necessary.

Image format
File type:

JPEG

Image quality:

Still Image Capture Settings

[¥] Capture as-is when re-encoding is not necessa

Folder for exported files

[v] Automatically generate a sul

bfolder for each clip switch

Under [File type], select the desired file format.

Select [TIFF] to save images as uncompressed 8-bit RGB TIFFs.

By default, [JPEG] saves images at the highest setting in [Image

quality].

When the file format specified in [File type] under [Image format]

is set to [JPEG] and [Capture as-is when re-encoding is not

necessary] is checkmarked, still images will be extracted from

movies without maodifications for the following movies. Faster

processing will be achieved.

* 4K movies shot with Canon Log gamma set to [Off]

« 4K movies shot with Canon Log gamma set to [On] without
applying an LUT

To specify the destination, click the [ [-| ] button under [Folder for

exported files] and choose the location in the [Browse For Folder]

dialog box.

To save still images in a new subfolder, checkmark

[Automatically generate a subfolder for each clip switch]. This

option prevents files from being renamed if the destination folder

already contains files with the same name.
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On the [File name] tab, complete the settings as

necessary and click the [OK] button.

The settings are now complete.

Still Image Capture Settings
General File name

Shared
[]Rename files

New file name

Include still image capture count
Still image capture count
00000
Reset the counter when a new clip is selected

Capture single still image

[¥] Add the time code to the file name

Ex.: CLIP_00000_HHMMSSFRIPG

Capture multiple still images (IN-OUT, Marker)

(®) Add the time code to the file name

(7) Add a consecutive number to the file name

Ex. CLIP_00000_HHMMSSFRIPG

The settings for the [Shared] items are as follows:

» To name still image files or edit existing names, checkmark
[Rename Files]. In [New file name], enter a name or change the
existing name. File names can be up to 30 characters. Note
that still image files cannot be renamed unless this option is
checkmarked. In such a case, the file name will be the same
with the original movie clip.

« To append a serial number to file names that indicates the
number of times still images have been captured from a movie
clip, checkmark [Include still image capture count]. In [Still
image capture count], enter the first serial number, in the range
0-99999.

« To reset the serial number in [Still image capture count] when
you select another movie clip, checkmark [Reset the counter
when a new clip is selected].

If the [Add the time code to the file name] checkbox of the
[Capture single still image] item is checked, a time code is
appended at the end of the file name when a single still image is
saved.
If [Add the time code to the file name] is selected for the [Capture
multiple still images (IN-OUT, Marker)] item, a time code is
appended at the end of each file name when multiple still images
are saved. When [Add a consecutive number to the file name] is
selected, consecutive numbers are appended at the end the file
names.
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Still Image Saving Controls

When you save still images, you can perform the following operation
with buttons.

In point marker (display only) Save a still image

Out point marker (display only) Save multiple
Marker (display only) | still images

Timecode 01:22:26:10 Duration 00:03:15:04
—
- \ r
0
= |

OWT O 200% v i
o slf@l [NIFIRPrer il » [w] b [pa o ag

i

Playback Rate x 1. A i
_ i

2

‘
[] —_—

8

il

&

P

Set the marker
Move the marker

Display the marker list

Save the frames at
Jump to the frame
all the marker

at the Out point " .
positions as still

Jump to the frame at images

the In point

Set the Out po*int
(ending point) 2

Digital Photo Professional 4
start button™*

Set the In poin}
(starting point)

" Digital Photo Professional 4 starts up and the still image that was
saved before the button was clicked will be displayed. Note that in
order to use this function, you must have version 4.3.20 or later of
Digital Photo Professional installed on your computer.

"2 These buttons specify the In (start) and Out (end) points when
specifying a playback range (p.11) or saving multiple still images
(p.18).

5
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1D C |: To save still images with the LUT applied, checkmark @ @

[LUT] checkbox.

Focal length, shutter speed, ISO speed, white balance and GPS

information in the shooting information appended to the image @.
are values when the movie shooting started. However, the date S
and time when the still image was actually shot will be calculated

and appended as shooting date and time. 17
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Introduction

Saving Individual Still Images Saving Multiple Still Images

By specifying a segment in the current movie clip, you can save all
frames within the segment as still images.

o . C
In the main window, select the [View] menu » ontents

[Clip list...].
The [Clip list] dialog box appears.
Select a movie clip in the [Clip list] dialog box.

Drag the frame position slider left or right to display
the frame to save.

' R Timecode 01:20:48:00 Duration 00:03:15:04 Playback Rate x 1.0 A1 i
o
Be
. 0] .
=X

CIWT O 200% v
) @i VY e |l » > A (A 0| (A= [re

Click the Capture still image button.

F ™ Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A0 i
-
£
i}
< A =
=X

CWT O 200% ~
o I AR A AT »> -0 | (A A A A= g

Capture still image button

A still image is saved following the settings in the [Still Image
Capture Settings] dialog box.

You can also click the Capture still image button during movie
playback to save still images. In this case, playback is paused as
the current frame is saved as a still image.

In the main window, select the [View] menu »
[Clip list...].

The [Clip list] dialog box appears.
Select a movie clip in the [Clip list] dialog box.

Drag the frame position slider left or right to display
the starting frame, and then click the In point button
when a frame from which you want to start saving
appears.

| [m
| | |7

i B Timecode 01:21:35:24 Duration 00:03:15:04 Playback Rate x 1.0 A
=
o A
® F e YT aF 4

Il > Lannll g 0 A+ +0 A

i

Preparation

Basic
Screen

Playing Back

Confirming File
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In point button  In point marker

The In point marker is now displayed, and the starting point for
still images to save is set.

You can also click this button during movie playback to specify
the In point.

Once you have specified the In point, you can jump to the frame
at the In point by clicking the [ [+ ] (move to IN point) button. If no
In point has been set, clicking this button jumps to the first frame.
You can also click the [ [1¢]] (move to IN point) button during
movie playback.

Saving

Exiting EMU
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Drag the frame position slider left or right to display
the ending frame, and then click the Out point
button.

Duration 00:03:15:04 Playback Rate x 1.0 A0

—

F N Timecode 01:22:26:10
- Al
[ A

——
Mrdes )

COWT O 200% ~

-0 @) ‘@1« vrsr  d > |Lannl 3 A A« R AE

0
o |

&S

1 |

Out point button Out point marker

The Out point marker is now displayed, and the ending point for
still images to save is set.

You can also click this button during movie playback to specify
the Out point.

Once you have specified the Out point, you can jump to the
frame at the Out point by clicking the [ [*7] ] (move to OUT point)
button. If no Out point has been set, clicking this button jumps to
the last frame. You can also click the [ [*F] ] (move to OUT point)
button during movie playback.

The maximum range between In and Out points is one hour.
The In and Out points can be removed from [Marker] on the main
window menu.

Select [Delete IN point], [Delete OUT point], or [Delete both IN
point and OUT point] as required.

Click the Capture multiple still images button.

R Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A
——

i
& Al 4 Hi=
) t (=)
OLWTO 200% v B-H
) @@ (Y Y el »> I A e R R g

Capture multiple still images button

Still images are saved following the settings in the [Still Image
Capture Settings] dialog box. All frames between the In and Out
points are saved as still images.

You can also click this button during movie playback to save still
images. In this case, playback is paused during capture.

@ The In and Out point settings in the selected clip are saved
automatically, and the settings continue to be effective the next time

you work with the clip in EMU.
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Saving All the Frames where Markers are
Set as Still Images

Click the [ ] button.

U

Iz R Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 -
——
&
[ A

0
(] (] (] (] []
OWTO 100% v
) Sal (@] [P [N [F 2 [ 4l > > |l A A 20 A=

i) m
o it

A0

=]
1
&

G

All the frames specified with the markers are saved as still
images using the settings made in the [Still Image Capture
Settings] window.

|§| You can also save all the specified frames with markers in the
procedures as below.

Click the [ 2= ] (Marker list) button in the control area
to display the marker list.

Click the [Capture all images] button in the marker
list.

 EEEEE—

Introduction

e

Contents

—

Preparation

—_—

Basic
Screen

—_—

Playing Back

—

Confirming File
Information

[

Saving

Exiting EMU

Reference

[

QO
©

20



 EEEEE—

Merging and Saving Movie Files

3 ( 10 C ) (1oxMmkil) (5DS/5DS R) (7D MK i)

You can use this function to merge multiple movie files that were split by
a camera, which are then saved as a single file. Note that this function
supports movies shot with [ 1D C | (1D X MkIl) (5DS/5DS R} (7D Mk 11} -

Introduction

In the [Clip list] dialog box, select the movie clip
whose structure you want to check, right-click with
the mouse, and select [Show structure of the clip]
from the menu that appears.

e

Contents

Checking the Movie Files in a Movie Clip

In EMU, the split movie files will be displayed as a single movie clip. You
can check the structure of a movie clip and see the movie files that
consist the movie clip in the procedures as below.

In the main window, select the [View] menu P [Clip
list...].

The [Clip list] dialog box appears.

To use this function, you must first select the folder in which the
movie clips to check are saved. If a folder is not selected, follow
steps 1 to 2 of “Movie Clip Playback” (p.6) to select a folder.

Clip list H

Display Mode: | 52

Sort | Shooting Date/Time v | | Ascending W

Clip Name Rating Comment
MVI_0001

Show structure of the clip )

MVI_Do10
Rating

Merge split files...

Enter Comments...

"

The [Structure of Clip] dialog box appears.

Structure of Clip “

Vlip name: MVI_0005

Fi \DCIM\moEosm\Mw_ooos.Mov)

F:\DCIM | 100E05 1D \MVI_DO06.MOV
F:\DCIM\100EOS1D \MVI_0007.MOV

Close

Movie file names are displayed
in several lines for a movie clip
made up of split movie files.
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Merging Split Movie Files and Saving as a
Single File
You can merge multiple split movie files composing a movie clip an

save them as a single file. The original movie files are kept as they
in the folder they were originally saved.

d
are

Merging All the Split Movie Files in the Folder

and Saving as a Single File

Click the Merge split files button in the main window.

F ™ Timecode 01:22:26:10 Duration 00:03:15:04 Playback Rate x 1.0 A0
——
-
0
[ A
COWT O 200% ~
-0 LS N[|LF ][N X212 dl > |Lannl 3 LR LS

= 1w |
-;gh"\ "

Merge split files button

The [Merge Files] dialog box appears.
In the main window, you can also select the [Tools] menu »
[Merge split files...] to display the [Merge Files] dialog box.

Merge Files EX]

Folder for fies to be merged

L]

Folder for exported fles

Automatically generate subfolders

Click the [ [..] ] button for [Folder for files to be
merged] and then select the folder in which the
movie files to be merged are saved.

Merge Files

Folder for files to be merged

Folder for exported files

All the movie files saved in the selected folder will be merged.
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(D Movie files shot with a camera are recorded on the memory card
with the folder structure shown below.

| DCIM 'I 100EOSXX 1 MvI_xxxx.MOV

or
100CANON

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

1 101E0Sxx 1 MVI_xxox. MOV
or
101CANON

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

I | 102EOSxx | MVI_xxxx.MOV
or
102CANON

MVI_xxxx.MOV

MVI_xxxx.MOV

MVI_xxxx.MOV

With this software, if the above folder structure is not maintained, it
may not be possible to merge the split movie files properly. When
performing “Merge all the split movie files in the folder and save as a
single file” operation, make sure the above folder structure is
maintained and the DCIM folder at the upper layer of the folder
structure is selected. Even when the folder structure is maintained,
be aware that it may not be possible to merge the movie files
properly if the name of the selected folder, originally [DCIM], has
been changed to another name.

Click the [ [..] ] button for [Folder for exported files]
and then select the folder for saving the merged
movie file.

Folder for files to be merged

L]

Folder for exported fies O

Automatically generate subfolders

Click the [Start] button.

Remember consecutive numbering

Saved files

[[Jindude unspiit dips

Start Cancel

Merging and saving starts.
A message appears when merging and saving are complete.

If you checkmark [Automatically generate subfolders], a subfolder
is created in the folder for the merged movie file selected in step
3, then the merged movie file is saved there. A file can be saved
without changing its file name even if another file with the same
file name is already in the folder.

If you checkmark [Rename files], you can change the file name of
the merged movie file when saving it.

To create file names with consecutive numbering, enter the initial
value in the [Initial value for consecutive numbers] box. You can
enter an initial value that is up to 5 digits. Checkmark [Remember
consecutive numbering] to allow consecutive numbering to
continue even after closing the [Merge Files] dialog box and
opening it again to merge and save movie files.

If you checkmark [Include unsplit clips], movie files not split but
saved in the folder selected in step 2 are copied to the folder for
saving the merged file together.
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Merging Split Movie Files for a Single Movie
Clip and Saving as a Single File

In the main window, select the [View] menu P [Clip
list...].
The [Clip list] dialog box appears.
Note that this function is available after you select a folder in
which the movie files to be merged are saved. If no folder is
selected, follow steps 1 to 2 of “Movie Clip Playback” (p.6) to
select a folder.

In the [Clip list] dialog box, select the movie clip to
be merged, then right-click and select [Merge split
files...] from the menu that appears.

The [Merge Files] dialog box appears.

Click the [ [-.]] button for [Folder for exported files]

and then select the folder for saving the merged
movie file.

Click the [Start] button.

Merging and saving starts.
A message appears when merging and saving are complete.

Exiting EMU
In the main window, select the [File] menu » [EXit].
EMU exits.
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Troubleshooting

If EMU is not operating correctly, refer to the information below.

EMU does not work

EMU does not operate properly on a computer which does not meet
the system requirements. Use EMU on a computer compatible with
system requirements (p.2).

Even if your computer has the RAM capacity (memory) that meets the
system requirements, if other applications are running at the same
time as EMU, you may not have sufficient RAM (memory). Exit
applications other than EMU.
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Error Messages

If an error message appears, refer to the information below.

Message

Cause and solution

Message

Cause and solution

Cannot write to the
selected path.

The memory card specified for the save
destination is write-protected. Insert a
writable memory card.

The merge process has
been failed.

Check that there is a save destination
folder. If the save destination folder is on an
external storage device, check that it is
connected to the computer correctly.

Please enter
consecutive numbers.

No consecutive numbering is entered.
Enter an initial value for consecutive
numbering when there are several movie
clips with movie files to be merged.

The size of the file you
are saving is not
supported on the
destination file system.

The file system specified for the save
destination does not support the size of the
file being saved. Change the save
destination.

Sufficient consecutive
numbers are not
provided for the files.

Consecutive numbering for file names
exceeds 99999. Change the value entered
for numbering or the file save destination.

EOS MOVIE Utility has
already started by other
user.

Log into the user account in Windows in
which EOS MOVIE Utility is running, exit
EOS MOVIE Utility, and start it up again.

4 GB or larger files may
not be supported on the
file system of output
destination. Do you
want to continue?

The merged movie file may not be saved to
the drive where the save destination folder
is located. Check that the file system
specified for the save destination drive
supports files of 4 GB or larger.

Could not merge
because there was not

enough available space.

There is insufficient space on the drive
where the save destination folder is
located. Create enough space or change
the save destination, and then repeat the
merge process.
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Keyboard Controls
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Controls focused on in main window

et GG DR D Volume slider Frame position slider
Space - Play/Stop
Shift+Space - Play range between In and Out points
- Raise volume Next frame
- Lower volume Previous frame
Shift+— Operation set with OS Raise volume Jump to Out point for multiple still images
Shift++ Lower volume Jump to In point for multiple still images
Shifte1 B Select ne;(f) rsrilt?(;lr(]earmbdegv;/:r?n current
Shift+l B Select ne;togggie; rl})gt(\;\;]eden current
Home - Jump to first frame
End - Jump to last frame
B Enable/Disable look-up table [LUT]
L Play
Shiftel Play range b_etween In and Out points _

When pressed in playback state: play again
K Stop
S Adjust playback speed
\% Switch display size
F Full screen display
Ctrl+S Save a still image
Ctri+T Save multiple still images
Ctrl+Alt+M Save all the frames where markers are set as still images
D Merge all split files in folder and save
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Uninstalling the Software

Before starting the software uninstallation, exit all programs you are
using.

Log in under the Administrator privileges when uninstalling the
software.

Uninstall the software according to the Windows software uninstalling
method.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Also, reinstalling the software
without first restarting your computer is likely to result in computer
malfunctions.
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About This Instruction Manual
It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.
Canon may change without notice the software specifications and
contents of this Instruction Manual.
The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.
Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks
Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
All other trademarks are the property of their respective owners.
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